ZILINSKIS CO

Priedas Nr. 2 prie Specialiyjy pirkimo salygy

PASIULYMAS
(2018-ESO-806) NV SKIRSTOMOJO VIDUTINIO SLEGIO DUJOTIEKIO IKI SKLYPU AZUOLU
G. KASTONU G. IR KT. GATVESE, MOKOLU K., MARIJAMPOLES R. PROJEKTAVIMO
PASLAUGOS IR STATYBOS DARBU PIRKIMUI

2018 m. rugpjticio 6 d. Nr. 08-222/1706
Jurbarkas

1. INFORMACIJA APIE TIEKEJA
Tiekéjo pavadinimas / Tiekéjy grupés nariy | “Zilinskis ir Co, UAB
pavadinimai
Tiekéjy  grupés  bendras  atstovas  arba | -
vadovaujantis narys (pildoma, jei pasiiilymgq teikia
Tiekejy grupé)

2. SUTIKIMAS SU PIRKIMO SALYGOMIS
Pazymime, kad pateikdami savo Pasifilyma, sutinkame su Pirkimo sglygose (kaip jos apibréZtos Bendrosiose
pirkimo sglygose) nustatytomis tolesnémis Pirkimo procediiromis ir biisimos Sutarties sglygomis (tiek
bendraja, tiek specialiaja dalimis).
Patvirtiname, kad atidZiai perskait¢éme visus Pirkimo salygy, taip pat ir Techninés specifikacijos,
reikalavimus, misy Pasitilymas juos visigkai atitinka ir jsipareigojame jy laikytis vykdydami Sutartj. Taip
pat jsipareigojame laikytis ir kity Lietuvos Respublikoje galiojanéiy ir Pirkimo objektui bei Sutardiai
tatkomy teisés akty reikalavimy. Rengdami Pasitilyma, atsizvelgéme j darby saugos ir darbo salygy
reikalavimus.
Jei bisime kvieCiami sudaryti Sutartj ir atsisakysime jg sudaryti, jsipareigojame, Pirkéjui pareikalavus,
sumoketi Jgaliojusiai organizacijai 10 proc. Dalyvio Pasitlymo kainos EUR be PVM dydZio baudg bei
padengti Jgaliojusios organizacijos patirtus tiesioginius nuostolius, kiek jy nepadengia auk3¢iau nurodyta
bauda.

3. INFORMACIJA APIE PLANUOJAMUS PASITELKTI SUTIEKEJUS AR REMIMASI
KITU UKIO SUBJEKTU PAJEGUMAIS
3.1.  Sutarties vykdymui bus pasitelkiami $ie Subtiekéjai ir Gikio subjektai:
Eil. | Ukio subjekto, kurio pajégumais | Kvalifikaciniy Reikalavimy kuriems atitikti bus naudojami kiti

Nr. remiamasi, Subtiekéjo tkio subjekto pajégumai ir darbai, kuriems bus pasitelkiami
pavadinimas' arba Ukio subjekto subtiekéjais, pobiidis?
(specialisto), kuris néra Tiekéjo (nurodyti atliekamus darbus pagal SPS 5 priedo II dalyje C
darbuotojas, vardas ir pavarde! punkte ,,Techniniai ir profesiniai reikalavimai® (nurodyti

konkrety punktq ir to punkto darby aprasymg) ir techninéje
specifikacijoje nurodytus darbus)

1 “Projektai ir Co*, UAB Projektavimo paslaugos, Priedo Nr. 5 prie SPS ,,II. Reikalavimai

kvalifikacijai* C 3 p., geodeziniai ir topografiniai darbai, Priedo

Nr. 5 prie SPS ,II. Reikalavimai kvalifikacijai* C 8 p.

2. A. Zilinskio ir ko UAB Melioracijos statiniy statybos darbai Priedo Nr. 5 prie SPS ,,IL
Reikalavimai kvalifikacijai“ C 9 p.
3. NeZinomas Gerbuvio atstatymas, tran$éjy kasimas ir uzpylimas, uzdaro

peréjimo kryptinio greZzimo darbai, bendrastatybiniai darbai,
skirstomyjy dujotiekiy vamzdyny ir jrenginiy remonto darbai;
skirstomyjy dujotiekiy vamzdyny ir jy irenginiy bandymo darbai

" Nurodomas konkretus Subtiekeéjo pavadinimas, jei Zinomas Pasililymy pateikimo metu. Jei ketinama pasitelkti, tadiau konkretus pavadinimas néra
Zinomas, nurodoma ,nezinomas*.

2 Toks perdavimas nekeicia pagrindinio Tiekéjo atsakomybés del numatomos sudaryti Sutarties jvykdymo.



Kartu su savo Pasitlymu pateikiame Okio subjekty, kuriy atliekamiems darbams keliami kvalifikaciniai
reikalavimai, daliai uzpildyta EBVPD.

Pirkéjui paprasius, pateiksime jrodymus, kad vykdant Sutarti mums bus prieinami lenteléje nurodyty tikio
subjekty pajégumai.

Tiekéjas / jungtinés veiklos dalyvis/ | Tiekéjas teikdamas pakartotinai Europos bendrgji
dkio subjektai, kuriy pajégumais | vieSyjy pirkimy dokumentq patvirtina, kad Siame
remiamasi dokumente esanti informacija yra teisinga ir aktuali*
“Projektai ir Co“, UAB X
“Zilinskis ir Co*, UAB
A. Zilinskio ir ko UAB X

*PASTABA: Vadovaujantis VP] 50 str. 3 d., 8i lentelé yra pildoma tik tuo atveju, kai su paraidkomis yra
pateikiami ankstesniy pirkimy Europos bendrieji vieSyjy pirkimy dokumentai, kurios Tiekéjai naudojo
ankstesnése pirkimo procedirose.

4. PASIULYMO KAINA
4.1. Pasiillymo kaina nurodoma eurais,
4.2. __Pasi_ﬁ]_qu I_;ain_g nu;_(_)_doma u_ipilc_l__ant pateikta lentelg:

tﬂiiS—ESO—Siﬁ NV. Skifétoﬁo;o v. iduﬁﬁio ‘slégld dﬁjotiekio iki sk]ypq 'udlq g., Kaitony g. lr kt.-
ug
gatvése, Mokoly k., Marijampolés r. projektavimo paslaugos ir statybos darbai

I etapas —Projekto parengimo darbai 20.000,00
II etapas — Rangos darbai 234.444,00
Kaina EUR be PVM: 254.444,00

Prideétinés vertes mokestis (PVM): 53.433,24

Kaina EUR su PVM 307.877,24

* Pasiilymo kaina EUR be PYM* yra lygi darby kainy ZiniaraStyje nurodytai ,,I§ viso kaina EUR be
PVM (projektiniam kiekiui).
Pasitilymo kaina turi apimti visas i$laidas, visus mokesdius, mokétinus pagal galiojanéius Lictuvos

Respublikos jstatymus, jskaitant saskaity pateikimo kastus per ..E. saskaita“ sistema. Laiméjusiam Dalyviui
bus sumokama tik uz faktiska kiekj.

5. PROJEKTAVIMO PASLAUGU IR RANGOS DARBU ATLIKIMO LAIKAS
e _ bk Nenutrukstamas_ 'projektawmo_
r statybos darbq "tl'

(2018-ESO-806) NV Skirstomojo vidutinio slégio dujotiekio lkl sklypq Azuolq g., Kastonq g. ir
kt. gatvése, Mokoly k., Marijampolés r. projektavimo paslaugos ir statybos darbai

Projektavimo paslaugy ir rangos darby atlikimo laikas (T1) 140

6. PASIULYMO GALIOGJIMO TERMINAS
Pasitilymas galioja BPS 9.1. punkte nurodyta termina,




7. PRIEDAI PRIE PASIULYMO FORMOS
Tiekeéjo rekvizitai ir kita informacija (privaloma uZpildyti), 1 lapas;
Konfidenciali informacija, 2 lapai;
7.3.  Priedas Nr. 3. Tinkamai jvykdyty arba vykdomy sutar¢iy sgrasas, 1 lapas;
7.4.  Priedas Nr. 4. Tiekéjo sitilomy specialisty sarasas, 1 lapas;

7.1.  Priedas Nr. 1.
. 2.
. 3.
A,
7.5.  Priedas Nr. 5. Deklaracija dél sutikimo buti Subtiekéju, 1 lapas;
. 6.
A
. 8.

7.2.  Priedas Nr

7.6.  Priedas Nr. 6. Deklaracija dél sutikimo biti jdarbintu Tiekéjo laiméjimo atveju, 1 lapas;

7.7.  Priedas Nr. 7. Tiekejy kvalifikacijg pagrindZian¢iy dokumenty sgrasas;

7.8.  Priedas Nr. 8. Deklaracija dél jungtinei veiklai susivienijusiy tiekéjy grupés dalyvavimo pirkime, 2
lapai.

*PASTABA: Priedy Nr. 4-8 su Pasitlymu pildyti ir pateikti nereikia. Dokumentus pateikti bus
praSoma galimai laiméjusio Dalyvio.

LlETU[/O

W jilymu pateikiamy dokumenty tikruma.
Bk |

iy 0

PasiraSydamas §j pasitilyma, tvirti

(Tiekejo arba jo jgaliotph '_-m 4 a_rda;,/ pavarde, paradas)®

2 Jei Pasitlymg Pirkimui pasirado vadovo jgaliotas asmuo, prie Pasillymo turi biti pridétas radytinis jgaliojimas arba kitas
dokumentas, suteikiantis para$o teise.



Priedas Nr. 1 prie Pasitilymo formos

TIEKEJO BANKININKYSTES INFORMACIJA IR DUOMENYS APIE KONTAKTINIUS
ASMENIS

Tiekéjo pavadinimas / Tiekéjy grupés nariy
pavadinimai

“Zilinskis ir Co*, UAB

Tiekéjo adresas(-ai)' (jei skiriasi, taip pat nurodyti ir
adresq korespondencijai)

Uztvankos g.17, Dainiai, LT-74202 Jurbarko r.

pavadinimas

Juridinio asmens kodas(-ai) (tuo atveju, jei Pasitilyma | 304317232

pateikig fizinis asmuo - verslo pazyméjimo Nr. ar pan.)

Tiekéjo PVM mokétojo kodas(-ai) LT100010333316

Tiekéjo / Tiekéjy grupés bendro atstovo arba | LT73 4010 0510 0370 6034
vadovaujan¢io nario sgskaitos numeris ir banko | Luminor Bank AB

Tiekéjo / Tiekéjy grupés bendro atstovo arba
vadovaujancio nario telefono numeris

Pasitilymo pasirasymui Tiekéjo / Tiekéjy grupés bendro
atstovo arba vadovaujanCio nario jgalioto asmens
pareigos, vardas, pavarde

Pasitilymg pateikusio Tiekéjo / Tiekéjy grupés bendro
atstovo arba vadovaujancio nario kontaktinio asmens
pareigos, vardas, pavarde

Pasitilymg pateikusio Tiekéjo / Tiekéjy grupés bendro
atstovo arba vadovaujancio nario kontaktinio asmens
telefono numeris / mobilaus telefono numeris

Pasitilymg pateikusio Tiek¢jo / Tiekéjy grupés bendro
atstovo arba vadovaujancio nario kontaktinio asmens
elektroninio pasto adresas

Sutarties vykdymui Tiekéjo / Tiekéjy grupés bendro
atstovo arba vadovaujancio nario jgalioto asmens
vardas, pavardé, tel. Nr., el. pastas.

Sutartj pasira§an¢io asmens vardas, pavardé, pareigos,
teisinis atstovavimo pagrindas , kuriuo suteikiama
asmeniui teisé pasirasyti sutartj jmonés vardu.

Tiekéjo / kiekvieno Tiekéjy grupés nariy dalyvio,
turin¢io balsy dauguma juridinio asmens dalyviy
susirinkime, pavadinimas

grupés neteikiami:
narys

Tiekéjas / | SPS priedo Nr. 5 lentelés I dalies D skirsnio 1 SPS priedo Nr. 5 lentelés I dalies D skirsnio
Tiekéjy | punkte nurodyta pagrinda jrodantys dokumentai 1 punkte nurodytg pagrindg jrodantys

dokumentai teikiami:

“Zilinskis
ir Co®,
UAB

Statybos rinkodaros departamento direktorius

—

" Tuo atveju, jei Pasitlymg teikia Tiekéjy grupé, pateikiama informacija apie visus Tiekéjy grupés narius.




KONFIDENCIALI INFORMACIJA

Priedas Nr. 2 prie Pasiiilymo formos

Atkreipiame Tiekeéjy démesj, kad Zemiau lenteléje nurodyta Pasiiilymuose pateikiama informacija bus vieSinama vadovaujantis
vieSuosius pirkimus reglamentuojanciy teis€s akty nuostatomis bei VieSyjy pirkimy tarnybos bei teismy formuojama praktika.

Eil.

Uzpildytos formos ir kita pateikiama

VieSinimo pagrindas

Pateikiamas

dokumentas skirtas

ParaisSkos ir/ar

kvalifikacijos atitikimo

Pateikiamas dokumentas
vieSinimui (iSskyrus
informacija, kurios
atskleidimas negalimas

(juridinio asmens) informacijg, nurodyta

VieSinama vadovaujantis ir VP] 20

]
A

1. SPS 1 priedas

Nr. | informacija’ jvertinimui? pagal Asmens duomeny
teisinés apsaugos
jstatyma)’

Pasitilymo forma (be priedy, bei Tiekéjo b b

]
-

1. SPS 1 priedas

dokumentai

18skyrus tokius kvalifikacija
pagrindziancius dokumentus, kuriuos
atskleidus biity pazeisti tiekéjo
Jsipareigojimai pagal su treCiaisiais
asmenimis sudarytas sutartis (VP] 20
str.2d. 3 p./PI32str. 2d. 3 p.).

1. | Sios pasitlymo formos 1 dalyje, kuri bet | straipsnio 2 dalimi / P] 32 straipsnio 2 (PF) pdf (PF) pf
kokiu atveju negali buti laikoma dalimi.
konfidencialia informacija)
VieSinama vadovaujantis VP] 20 st e
straipsnio 2 dalimi/ P] 32 straipsnio 2
2. | Tiekéjo rekvizitai ir kita informacija dalimi, i§skyrus informacija, kurios K S1PS ! %riEd‘;]((PF) - st ! %”ed%]EPF)
atskleidimas negalimas pagal Asmens priecas-p priecasp
duomeny teisinés apsaugos jstatyma.
VieSinama vadovaujantis VPT ir e i
teismy formuojama praktika, kad
tiekéjo kvalifikaciniai duomenys, 2. EBVPD.pdf 2. EBVPD.pdf
kuriais tiekéjas remiasi siekdamas
laiméti vieSajj pirkima, negali biti
3 Tiekéjo EBVPD forma ir pagrindZiantys | laikomi konfidencialia informacija,

" Atskiri dokumentai ar Siuose dokumentuose pateikiama informacija gali biti nurodoma atskirose eilutése, atsizvelgiant j informacijos konfidencialuma. Atsizvelgiant j informacijos
konfidencialuma, pateikiami konfidencialuma jrodantys dokumentai ir argumentai.

2 Dokumentas jkeliamas: INSERT -> Object -> Create From File -> Browse -> Display as icon -> ok.
® Dokumentas jkeliamas: INSERT -> Object -> Create From File -> Browse -> Display as icon -> ok. Pateiktas dokumentas laiméjimo atveju bus pavie$intas. Tiekéjas
jsipareigoja uztikrinti, kad dokumente néra konfidencialios ir negalimos viesinti informacijos.




Subtiekéjy EBVPD forma ir
pagrindziantys dokumentai

VieSinama vadovaujantis VPT ir
teismy formuojama praktika, kad
tiek¢jo kvalifikaciniai duomenys,
kuriais tiekéjas remiasi siekdamas
laiméti vieSaj] pirkima, negali biti
laikomi konfidencialia informacija,
18skyrus tokius kvalifikacija
pagrindziancius dokumentus, kuriuos
atskleidus bty pazeisti tiekejo
Jsipareigojimai pagal su treCiaisiais
asmenimis sudarytas sutartis (VP] 20
str.2d.3p./PI32str.2d.3p.).

o
2. EBVPD (PCo).pdf

!
o

2. EBVPD
(AZKO).pdf

]
g

2. EBVPD (PCo).pdf

!
o

2. EBVPD
(AZKO).pdf

Tiekéjo sitilomy specialisty sarasas

VieSinama vadovaujantis VP] 20
straipsnio 2 dalimi/ P] 32 straipsnio 2
dalimi, pateikta informacija, i§skyrus
informacija, kurios atskleidimas
negalimas pagal Asmens duomeny
teisinés apsaugos jstatyma.

Neteikiama

Neteikiama

Tiekejy kvalifikacija pagrindzianciy
dokumenty sgraSas

VieSinama vadovaujantis VP] 20
straipsnio 2 dalimi/ P] 32 straipsnio 2
dalimi, pateikta informacija, iSskyrus
informacija, kurios atskleidimas
negalimas pagal Asmens duomeny
teisinés apsaugos jstatyma.

Neteikiama

Neteikiama

VI Registry centro LR Vyriausybés
nustatyta tvarka iSduotas dokumentas,
patvirtinantis jungtinius kompetentingy
institucijy tvarkomus duomentis.

VieSinama vadovaujantis VP] 20
straipsnio 2 dalimi/ P] 32 straipsnio 2
dalimi, pateikta informacija, iSskyrus
informacija, kurios atskleidimas
negalimas pagal Asmens duomeny
teisinés apsaugos jstatyma.

Neteikiama

Neteikiama

Subtiekejo deklaracija dél sutikimo biiti
subtiekéju

VieSinama vadovaujantis VP] 20
straipsnio 2 dalimi/ P] 32 straipsnio 2
dalimi, pateikta informacija, iSskyrus
informacija, kurios atskleidimas
negalimas pagal Asmens duomeny
teisinés apsaugos jstatyma.

Neteikiama

Neteikiama

Darby kainy Ziniarastis (DKZ)

VieSinama vadovaujantis VP] 20
straipsnio 2 dalimi/ P] 32 straipsnio 2
dalimi, VPT ir teismy formuojama

3. Darby jkainiy
lentelé.xlsx

3. Darby jkainiy
lentelé.xlsx




praktika, i§skyrus darby kainos
(jskaitant jkainius) sudedamasias dalis.

Siekiant uztikrinti, kad laiméjusiy Dalyviy pasitilymuose esancios informacijos paskelbimas nepriesStarauty teisés akty reikalavimams,
teisétiems Tiekejy interesams arba netrukdyty laisvai konkuruoti tarpusavyje, praSome nurodyti, ar Pasitilyme yra konfidencialios
informacijos ir kokia Pasiiilyme nurodyta informacija yra konfidenciali.*

Pateikiamas Pateikiamas
dokumentas skirtas dokumentas vieSinimui
. . cps Pasiulymo ir/ar (iSskyrus informacija,
Eil. | Uzpildytos formos ir kita Ar dokum.entas Kokiu pagrindu atitinkamas kvalifikacijos kurios atskleidimas
ot . .. s | konfidencialus? dokumentas yra cper e s s .6 .
Nr. | pateikiama informacija . . atitikimo jvertinimui negalimas pagal
(Taip / Ne) (ne)konfidencialus?
Asmens duomeny
teisinés apsaugos
istatyma)’
Informacija gali buti laikytina
Jungtinés veiklos sutartis konfidencialia, iSskyrus atvejus,
1. | (jei Pasililymg pateikia Taip / Ne jeigu atitinkama informacija Neteikiama Neteikiama
Tiekejy grupe) skelbiama viesai arba tiekéjas
nurodo, kad néra konfidencialu.
De.klayacue.t c}el ]ungt et . Informacija laikytina i _
2. | veiklai susivienijusiy tiekéjy | Taip A Neteikiama Neteikiama
. . . konfidencialia.
grupés dalyvavimo pirkime

Statybos rinkodaros departamento direktorius

(Tiekéjo arba jo jgalioto asmens pareigos, vardas, pavarde, parasas)®

&

4 Lenteléje zemiau pateikiama informacija apie Pasitlyme nurodytos informacijos konfidencialumg. Dalyvis privalo nurodyti, ar jo Pasitlyme yra konfidencialios
informacijos, ir kuri Pasitlyme nurodyta informacija yra konfidenciali. Nurodant, jog informacija yra konfidenciali, praSome kartu su paraiSka/pasiiilymu pateikti
konfidencialuma jrodanéius dokumentus ir argumentus. Visas Dalyvio Pasidlymas negali bati laikomas konfidencialia informacija.

Tuo atveju, jei lentelé ar atskiros jos eilutés néra uzpildomos, Pirkéjas laikys, kad ta Pasialymo informacija arba atitinkama jos dalis néra laikoma
konfidencialia.

Atkreipiame démesj, kad vadovaujantis VP] ir (arba atitinkamai P]), Konfidencialia negali bati laikoma informacija, kuri atitinka VP] 20 straipsnio 2 dalyje ir (arba
atitinkamai P] 32 straipsnio 2 dalyje) nustatytus pozymius ir salygas, o Pirkéjui kilus abejoniy dél Dalyvio PasiGlyme nurodytos informacijos konfidencialumo, ji
kreipiasi j Dalyvj su praSymu jrodyti nurodytos informacijos konfidencialumg. Per Pirkéjo nurodytg terming (kuris negali bati trumpesnis kaip 5 darbo dienos) Dalyviui
nepateikus tokiy jrodymy arba pateikus netinkamus jrodymus, laikoma, kad tokia Pasidlyme nurodyta informacija yra nekonfidenciali.

5 Atskiri dokumentai ar Siuose dokumentuose pateikiama informacija gali bati nurodoma atskirose eilutése, atsizvelgiant j informacijos konfidencialuma.

® Dokumentas jkeliamas: INSERT -> Object -> Create From File -> Browse -> Display as icon -> ok.

" Dokumentas jkeliamas: INSERT -> Object -> Create From File -> Browse -> Display as icon -> ok. Pateiktas dokumentas laiméjimo atveju bus pavie$intas. Tiekéjas
jsipareigoja uztikrinti, kad dokumente néra konfidencialios ir negalimos viesinti informacijos.

8 Jei Pasialymg Pirkimui pasirago vadovo jgaliotas asmuo, prie Pasidlymo turi biti pridétas raytinis jgaliojimas arba kitas dokumentas, suteikiantis paraso teise.




Europos bendrasis viesuj irkim
dokul?'nentas (EBVPD) wu p “

I dalis. Informacija apie pirkimo procedura ir perkanciaja
organizacija ar perkantiji subjekta

Informacpia apie paskelbima

Vykdant pirkimo procedaras, kuriy kvietimas dalyvauti konkurse paskelbtas
Europos Sajungos oficialiajame leidinyje, informacija, kurios reikalaujama pagal

| dalj, bus atsiysta automatiskai, jeigu EBVPD sukurti ir uzpildyti naudojama
elektroniné EBVPD paslauga. Atitinkamo skelbimo Europos Sgjungos oficialiajame
leidinyje nuoroda:

Skelbimo numeris OL S:

OL S URL

National Official Journal

Jei kvietimas dalyvauti konkurse neskelbiamas Europos Sajungos oficialiajame
leidinyje arba jei jo skelbti nereikalaujama, perkancioji organizacija arba
perkantysis subjektas turi jrasyti informacija, kuri leisty nedviprasmiskai atpazinti
pirkimo procedurg (pvz., paskelbimo nacionaliniu lygmeniu nuorodg).

Perkanciojo subjekto tapatybé

Oficialus pavadinimas:

UAB "Verslo aptarnavimo centras"”
Salis:

Lietuva

Informacija apie pirkimo procedura

Type of procedure

Open procedure

Vardas ir pavardeé / Pavadinimas:

(2018-ESO- 519) NV vidutinio slégio skirstomojo dujotiekio iki sklypy Birutés g.,
Maironio g. ir kt. gatvése, Radviliskis, RadviliSkio m. sav., projektavimo paslaugos
ir statybos darby pirkimas

Trumpas aprasymas:



(2018-ESO- 519) NV vidutinio slégio skirstomojo dujotiekio iki sklypy Birutés g.,
Maironio g. ir kt. gatvése, Radviliskis, RadviliSkio m. sav., projektavimo paslaugos
ir statybos darbai

Perkanciosios organizacijos ar perkanciojo subjekto (jei taikoma)
priskirtas dokumento numeris:

2018-ESO-519

Il dalis. Informacija apie ekonominés veiklos vykdytoja

A. Informacija apie ekonominés veiklos vykdytoja

Vardas ir pavardeé / Pavadinimas:
“Zilinskis ir Co", UAB

Gatveé ir namo numeris:
Uztvankos g. 17

Pasto kodas:

74202

Miestas:

Dainiai, Jurbarko raj.

Salis:

Lietuva

Interneto adresas (jei taikoma):
www.zilinskis.com

E. pastas:

info@zilinskis.com

Telefonas:

+370 447 70120

Asmuo ar asmenys rySiams:

PVM mokeétojo kodas, jei yra:

LT100010333316

Jei PVM mokeétojo kodo néra, nurodykite kita nacionalinj identifikacini
numerij (jei reikia ir jei toks yra)

Ar ekonominés veiklos vykdytojas yra labai maza, mazoji ar vidutiné
imoné?

OTaip

®Ne



Tik tuo atveju, kai pirkimas rezervuotas: ar ekonominés veiklos
vykdytojas yra globojama darbo grupé (neigaliuju socialiné imonée),
socialiné imoné? Ar jis vykdys sutarti pagal globojamuy darbo grupiuy
(neigaliuju socialiniy imoniu) uzimtumo programas?

OTaip

®Ne

Jei taikoma, ar ekonominés veiklos vykdytojas itrauktas i oficialy
patvirtinty ekonominés veiklos vykdytoju sarasa arba ar jis turi
lygiaverti sertifikata (pvz., pagal nacionaline (iSankstine) kvalifikacijos
vertinimo sistema)?

OTaip

®Ne

« Be to, uzpildykite trukstama informacija IV dalies A, B, C arba D skirsniuose,
atsizvelgdami | konkrety atvejj TIK jei to reikalaujama atitinkamame skelbime
arba pirkimo dokumentuose:

e) Ar ekonominés veiklos vykdytojas galés pateikti sertifikata dél
socialinio draudimo imokuy ir mokesciuy mokéjimo arba pateikti
informacija, kuri leisty perkanciajai organizacijai ar perkanciajam
subjektui ji gauti tiesiogiai naudojantis prieiga prie bet kurios is
valstybiuy nariu nemokamos nacionalinés duomenu bazés?

@ Taip

ONe

Jei atitinkami dokumentai prieinami elektroniniu budu, nurodykite:
http://draudejai.sodra.lt/draudeju_viesi_duomenys/

Ar ekonominés veiklos vykdytojas pirkimo proceduroje dalyvauja kartu
su kitais?

OTaip

®Ne

Jei taikytina, nuroda i pirkimo dali (-is), dél kurios (-iu) ekonominés
veiklos vykdytojas nori dalyvauti konkurse:



B. Informacija apie ekonominés veiklos vykdytojo teisinius atstovus #1

« Jei taikytina, nurodykite asmens (-y), jgalioto (-y) atstovauti ekonominés
veiklos vykdytojui Sios pirkimo proceddros tikslais, varda ir pavarde ir adresa:

C. Informacija apie réemimasi kity subjekty pajégumais

Ar siekdamas patenkinti IV dalyje nurodytus atrankos kriterijus ir V
dalyje nurodytus kriterijus bei taisykles (jei tokiy yra) ekonominés
veiklos vykdytojas remiasi kity subjekty pajégumais?

@ Taip

ONe



+ Dél kiekvieno i$ susijusiy subjekty pateikite atskirg, ty subjekty tinkamai
uzpildyta ir pasirasyta EBVPD formg su informacija, kurios reikalaujama pagal
Sios dalies A ir B skirsnius ir Il dalj.

Atkreipkite démesj, kad reikéty jtraukti ir visus specialistus arba technines
jstaigas, nepriklausomai nuo to, ar jie tiesiogiai priklauso ekonominés veiklos
vykdytojo jmonei, pirmiausia atsakingus uz kokybés kontrole, o vieSojo
darby pirkimo sutarciy atveju - specialistus arba technines jstaigas, | kuriuos
ekonominés veiklos vykdytojas gali kreiptis, siekdamas atlikti darbg.

Jei svarbu pranesti apie konkrety pajéguma arba pajégumus, kuriais remiasi
ekonominés veiklos vykdytojas, IV ir V dalyse reikalaujama informacija
pateikite apie kiekvieng susijusj subjekta.

D. Informacija apie subrangovus, kuriy pajégumais ekonominés veiklos

vykdytojas nesiremia

« (Skirsnj reikia pildyti, tik jei Sios informacijos aiskiai reikalauja perkancioji
organizacija ar perkantysis subjektas.)

Ar ekonominés veiklos vykdytojas ketina kurias nors sutarties dalis
subrangos sutartimi pavesti atlikti treCiosioms salims?

@ Taip

ONe

Jei taip ir tiek, kiek Zinoma, iSvardykite siulomus subrangovus:
Nezinomas

+ Jei perkancioji organizacija ar perkantysis subjektas aiSkiai praso Sios
informacijos, Salia informacijos pagal Sj skirsnj, pateikite pagal Sios dalies
A ir B skirsnius ir lll dalj reikalaujamg informacijg apie kiekvieng susijusj
subrangova (subrangovy kategorijas).

11l dalis. Pasalinimo pagrindai

A. Su baudziamaisiais nuosprendziais susije pagrindai

Direktyvos 2014/24/ES 57 straipsnio 1 dalyje nustatyti Sie pasalinimo
pagrindai
Dalyvavimas nusikalstamos organizacijos veikloje
Ar pats ekonomineés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
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sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu, buvo
nuteistas galutiniu teismo sprendimu uz dalyvavima nusikalstamos organizacijos
veikloje, o nuosprendis priimtas pries ne daugiau kaip penkerius metus arba kai
nuosprendyje aiskiai nustatytas pasalinimo laikotarpis tebesitesia? Kaip apibrézta
2008 m. spalio 24 d. Tarybos pamatinio sprendimo 2008/841/TVR dél kovos su
organizuotu nusikalstamumu 2 straipsnyje (OL L 300, 2008 11 11, p. 42).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Korupcija

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar prieziiros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu, buvo
nuteistas galutiniu teismo sprendimu uz korupcijg, o nuosprendis priimtas pries ne
daugiau kaip penkerius metus arba kai nuosprendyje aiSkiai nustatytas pasalinimo
laikotarpis tebesitesia? Kaip apibrézta Konvencijos dél kovos su korupcija, susijusia
su Europos Bendrijy pareigunais ar Europos Sgjungos valstybiy nariy pareigtnais,
3 straipsnyje (OL C 195, 1997 6 25, p. 1) ir 2003 m. liepos 22 d. Tarybos pamatinio
sprendimo 2003/568/TVR dél kovos su korupcija privaciame sektoriuje 2 straipsnio
1 dalyje (OL L 192, 2003 7 31, p. 54). | pasalinimo pagrindus taip pat jtraukta
korupcija, kaip apibrézta perkanciosios organizacijos (perkanciojo subjekto) arba
ekonominés veiklos vykdytojo nacionalingje teiséje.

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Sukciavimas



Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz sukciavimg, o nuosprendis priimtas
prieS ne daugiau kaip penkerius metus arba kai nuosprendyje aiskiai nustatytas
pasalinimo laikotarpis tebesitesia? Pagal Europos Bendrijy finansiniy interesy
apsaugos konvencijos 1 straipsnj (OL C 316, 1995 11 27, p. 48).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Teroristiniai nusikaltimai arba su teroristine veikla susije nusikaltimai

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz teroristinius nusikaltimus arba

su teroristine veikla susijusius nusikaltimus, o nuosprendis priimtas pries ne
daugiau kaip penkerius metus arba kai nuosprendyje aiSkiai nustatytas pasalinimo
laikotarpis tebesitesia? Kaip apibrézta 2002 m. birzelio 13 d. Tarybos pamatinio
sprendimo dél kovos su terorizmu 1 ir 3 straipsniuose (OL L 164, 2002 6 22, p. 3).
| pasalinimo pagrindus taip pat jtrauktas nusikalstamos veikos kurstymas, pagalba
ar bendrininkavimas jg vykdant arba keésinimasis jg jvykdyti, kaip nurodyta to
pamatinio sprendimo 4 straipsnyje.

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Piniguy plovimas arba teroristy finansavimas



Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz pinigy plovimg arba teroristy
finansavima, o nuosprendis priimtas pries ne daugiau kaip penkerius metus

arba kai nuosprendyje aiskiai nustatytas pasalinimo laikotarpis tebesitesia? Kaip
apibrézta 2005 m. spalio 26 d. Europos Parlamento ir Tarybos direktyvos 2005/60/
EB dél finansy sistemos apsaugos nuo jos panaudojimo pinigy plovimui ir teroristy
finansavimui 1 straipsnyje (OL L 309, 2005 11 25, p. 15).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Vaiku darbas ir kitos prekybos Zzmonémis formos

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz vaiky darbg arba kitas prekybos
zmonémis formas, o nuosprendis priimtas pries ne daugiau kaip penkerius metus
arba kai nuosprendyje aiskiai nustatytas pasSalinimo laikotarpis tebesitesia?

Kaip apibrézta 2011 m. balandzio 5 d. Europos Parlamento ir Tarybos direktyvos
2011/36/ES deél prekybos Zmonémis prevencijos, kovos su ja ir auky apsaugos,
pakeiciancios Tarybos pamatinj sprendimg 2002/629/TVR, 2 straipsnyje (OL L 101,
2011 4 15, p. 1).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne



B. Su mokesciy ar socialinio draudimo imoky mokéjimu susije pagrindai

Direktyvos 2014/24/ES 57 straipsnio 2 dalyje nustatytos Sios pasalinimo
priezastys

Mokesciu mokéjimas

Ar ekonominés veiklos vykdytojas pazeidé savo pareigas, susijusias su mokesciy
mokéjimu, tiek Salyje, kurioje yra jsisteiges, tiek perkanciosios organizacijos ar
perkanciojo subjekto valstybéje naréje, jei tai néra jo jsisteigimo Salis?

Jusy atsakymas

OTaip

®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Socialinio draudimo imokuy mokeéjimas

Ar ekonomineés veiklos vykdytojas pazeidé savo pareigas, susijusias su socialinio
draudimo jmoky mokeéjimu, tiek Salyje, kurioje yra jsisteiges, tiek perkanciosios
organizacijos ar perkanciojo subjekto valstybéje naréje, jei tai néra jo jsisteigimo
Salis?

Jusy atsakymas

OTaip

®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

@ Taip

ONe

URL

http://draudejai.sodra.lt/draudeju_viesi_duomenys/

Kodas

191630223

Emitentas

Valstybinio socialinio draudimo fondo valdyba prie Socialinés apsaugos ir darbo
ministerijos



C. Su nemokumu, interesy konfliktu ar profesiniais nusizengimais susije

pagrindai

Direktyvos 2014/24/ES 57 straipsnio 4 dalyje nustatyti Sie pasalinimo
pagrindai

Nemokumas

Ar ekonominés veiklos vykdytojui taikoma nemokumo ar likvidavimo procedura?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Susitarimas su kreditoriais

Ar ekonomineés veiklos vykdytojas yra sudares susitarima su kreditoriais?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazeje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Sustabdyta verslo veikla

Ar ekonominés veiklos vykdytojo verslo veikla yra sustabdyta?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Su kitais ekonominés veiklos vykdytojais sudaryti susitarimai, kuriais
siekta iskraipyti konkurencija
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Ar ekonominés veiklos vykdytojas su kitais ekonominés veiklos vykdytojais yra
sudares susitarimy, kuriais siekta iSkraipyti konkurencijg?

Jusy atsakymas

OTaip

®Ne

Pripazinimas kaltu dél sunkaus profesinio nusizengimo

Ar ekonominés veiklos vykdytojas yra pripazintas kaltu dél sunkaus profesinio
nusizengimo? Jei taikytina, zr. nacionalinéje teiséje, atitinkamame skelbime ar
pirkimo dokumentuose pateiktas apibreéztis.

Jusy atsakymas

OTaip

®Ne

Interesy konfliktas dél dalyvavimo pirkimo proceduroje

Ar ekonominés veiklos vykdytojas Zino apie kokius nors interesy konfliktus, kaip
nurodyta nacionalinéje teisése, atitinkamame skelbime ar pirkimo dokumentuose,
kylancius dél jo dalyvavimo pirkimo proceduroje?

Jusy atsakymas

OTaip

®Ne

Tiesioginis arba netiesioginis dalyvavimas rengiant Sia pirkimo
procedura

Ar ekonominés veiklos vykdytojas arba su juo susijusi jmoné konsultavo
perkancigjg organizacijg ar perkantjjj subjekta arba kitaip dalyvavo rengiant
pirkimo procedurg?

Jusy atsakymas

OTaip

®Ne

Sutarties nutraukimas anksciau laiko, zala ar kitos panasios sankcijos
Ar ekonominés veiklos vykdytojas turéjo tokios patirties: ankstesné viesoji
sutartis, ankstesné sutartis su perkanciuoju subjektu arba ankstesné koncesijos
sutartis buvo nutraukta anksciau laiko; arba buvo pareikalauta atlyginti su
ankstesne sutartimi susijusig zalg ar skirtos kitos panasios sankcijos?

Jusy atsakymas
OTaip
®Ne
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Pripazinimas kaltu dél fakty iskraipymo, informacijos nuslépimo,
negaléjimas pateikti reikalaujamu dokumentuy ir su Sia procedura
susijusios konfidencialios informacijos gavimas

Ar ekonominés veiklos vykdytojas yra susijes su vienu is Siy atvejuy, kai jis :

a) buvo labai iSkreipes faktus pateikdamas informacija, reikalinga patikrinti, ar
néra pagrindy pasalinti, arba patikrinti atitiktj atrankos kriterijams;

b) slépé tokiag informacija;

c) delsé pateikti patvirtinamuosius dokumentus, kuriy reikalavo perkancioji
organizacija ar perkantysis subjektas, ir

d) siekeé daryti neteisétg jtakg perkanciosios organizacijos ar perkanciojo subjekto
sprendimy priémimo procesui, kad gauty konfidencialios informacijos, dél kurios
per pirkimo procedlrg jgyty nepagrista pranasuma, arba tycia teikti klaidinancios
informacijos, kuri gali turéti esminés jtakos sprendimams dél pasalinimo, atrankos
ar sutarties skyrimo?

Jusy atsakymas
OTaip
®Ne

D. ISimtinai nacionaliniai pasalinimo pagrindai

Ar taikomi iSimtinai nacionaliniai pasalinimo pagrindai, nurodyti
atitinkamame skelbime ar pirkimo dokumentuose?

ISimtinai nacionaliniai pasalinimo pagrindai

Kiti pasalinimo pagrindai, kurie gali bGti numatyti perkanciosios organizacijos
ar perkanciojo subjekto valstybés narés nacionalinés teisés aktuose. Ar taikomi
iSimtinai nacionaliniai pasalinimo pagrindai, nurodyti atitinkamame skelbime ar
pirkimo dokumentuose?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

IV dalis. Atrankos kriterijai
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a. Visy atrankos kriterijy bendra nuoroda

Dél atrankos kriteriju ekonominés veiklos vykdytojas pareiskia, kad
Jis atitinka visus reikalaujamus atrankos kriterijus

Jlusy atsakymas

@ Taip

ONe

Baigti

IV dalis. Baigiamieji pareiskimai

Ekonominés veiklos vykdytojai oficialiai pareiSkia, kad II-V dalyse pateikta

informacija yra tiksli ir teisinga ir kad ji pateikta visisSkai suvokiant didelio fakty

iSkreipimo padarinius.
Ekonominés veiklos vykdytojai oficialiai pareiskia, kad pareikalavus gali
nedelsdami pateikti nurodytus sertifikatus ir kity formy jrodomuosius
dokumentus, iSskyrus tuo atvejus, kai:
a) perkancioji organizacija ar perkantysis subjektas turi galimybe atitinkamus
patvirtinamuosius dokumentus tiesiogiai gauti naudodamiesi prieiga prie bet
kurios i$ valstybiy nariy nemokamos nacionalinés duomeny bazés (su salyga,
kad ekonominés veiklos vykdytojas pateiké reikalingg informacija (interneto
adresg, iSduodanciajg institucijg ar jstaiga, tikslias dokumenty nuorodas),
kuri perkanciajai organizacijai ar perkanciajam subjektui leidzia tai padaryti.
Pareikalavus dél tokios prieigos turi buti pridetas atitinkamas sutikimas) arba
b) (priklausomai nuo Direktyvos 2014/24/ES 59 straipsnio 5 dalies antros
pastraipos jgyvendinimo nacionalingje teiséje) ne véliau kaip 2018 m. spalio
18 d. perkancioji organizacija ar perkantysis subjektas yra gavusi susijusius
dokumentus.
Ekonominés veiklos vykdytojai oficialiai sutinka [nurodyti perkanciaja
organizacijg ar perkantjjj subjekta, kaip nustatyta | dalies A skirsnyje] leisti
susipazinti su dokumentais, kuriais patvirtinama informacija, pateikta Sio
Europos bendrojo viesyjy pirkimy dokumento [nurodyti atitinkama dalj /
skirsnj / punkta (-us)], dél [nurodyti vieSojo pirkimo procedura: (trumpas
aprasymas, paskelbimo Europos Sajungos oficialiajame leidinyje nuoroda,
nuorodos numeris)].

Data, vieta ir, jei reikia ar batina, parasas (-ai):

Data

03-05-2018

-13-



Vieta
Jurbarkas
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Europos bendrasis viesuj irkim
dokul?'nentas (EBVPD) wu p “

I dalis. Informacija apie pirkimo procedura ir perkanciaja
organizacija ar perkantiji subjekta

Informacpia apie paskelbima

Vykdant pirkimo procedaras, kuriy kvietimas dalyvauti konkurse paskelbtas
Europos Sajungos oficialiajame leidinyje, informacija, kurios reikalaujama pagal

| dalj, bus atsiysta automatiskai, jeigu EBVPD sukurti ir uzpildyti naudojama
elektroniné EBVPD paslauga. Atitinkamo skelbimo Europos Sgjungos oficialiajame
leidinyje nuoroda:

Skelbimo numeris OL S:

OL S URL

National Official Journal

Jei kvietimas dalyvauti konkurse neskelbiamas Europos Sajungos oficialiajame
leidinyje arba jei jo skelbti nereikalaujama, perkancioji organizacija arba
perkantysis subjektas turi jrasyti informacija, kuri leisty nedviprasmiskai atpazinti
pirkimo procedurg (pvz., paskelbimo nacionaliniu lygmeniu nuorodg).

Perkanciojo subjekto tapatybé

Oficialus pavadinimas:

UAB Verslo aptarnavimo centras
Salis:

Lietuva

Informacija apie pirkimo procedura

Type of procedure

Open procedure

Vardas ir pavardeé / Pavadinimas:

(2018-ESO-757) NV didelio slégio skirstomojo dujotiekio iki sklypy Darzy g.,
Pamiskes g. ir kt. gatvése, Rietavas, Rietavo sav. projektavimo paslaugos ir
statybos darbai

Trumpas aprasymas:



(2018-ES0O-757) NV didelio slégio skirstomojo dujotiekio iki sklypy Darzy g.,
Pamiskés g. ir kt. gatvése, Rietavas, Rietavo sav. projektavimo paslaugos ir
statybos darbai

Perkanciosios organizacijos ar perkanciojo subjekto (jei taikoma)
priskirtas dokumento numeris:

(2018-ESO-757)

Il dalis. Informacija apie ekonominés veiklos vykdytoja

A. Informacija apie ekonominés veiklos vykdytoja

Vardas ir pavardeé / Pavadinimas:
A. Zilinskio ir ko UAB

Gatveé ir namo numeris:
Uztvankos g. 17

Pasto kodas:

74202

Miestas:

Dainiai, Jurbarko raj.

Salis:

Lietuva

Interneto adresas (jei taikoma):
www.zilinskis.com

E. pastas:

info@zilinskis.com

Telefonas:

+370 447 70120

Asmuo ar asmenys rySiams:

PVM mokeétojo kodas, jei yra:

LT581021411

Jei PVM mokeétojo kodo néra, nurodykite kita nacionalinj identifikacini
numerij (jei reikia ir jei toks yra)

Ar ekonominés veiklos vykdytojas yra labai maza, mazoji ar vidutiné
imoné?

OTaip

®Ne



Tik tuo atveju, kai pirkimas rezervuotas: ar ekonominés veiklos
vykdytojas yra globojama darbo grupé (neigaliuju socialiné imonée),
socialiné imoné? Ar jis vykdys sutarti pagal globojamuy darbo grupiuy
(neigaliuju socialiniy imoniu) uzimtumo programas?

OTaip

®Ne

Jei taikoma, ar ekonominés veiklos vykdytojas itrauktas i oficialy
patvirtinty ekonominés veiklos vykdytoju sarasa arba ar jis turi
lygiaverti sertifikata (pvz., pagal nacionaline (iSankstine) kvalifikacijos
vertinimo sistema)?

OTaip

®Ne

« Be to, uzpildykite trukstama informacija IV dalies A, B, C arba D skirsniuose,
atsizvelgdami | konkrety atvejj TIK jei to reikalaujama atitinkamame skelbime
arba pirkimo dokumentuose:

e) Ar ekonominés veiklos vykdytojas galés pateikti sertifikata dél
socialinio draudimo imokuy ir mokesciuy mokéjimo arba pateikti
informacija, kuri leisty perkanciajai organizacijai ar perkanciajam
subjektui ji gauti tiesiogiai naudojantis prieiga prie bet kurios is
valstybiuy nariu nemokamos nacionalinés duomenu bazés?

@ Taip

ONe

Jei atitinkami dokumentai prieinami elektroniniu budu, nurodykite:
http://draudejai.sodra.lt/draudeju_viesi_duomenys/

Ar ekonominés veiklos vykdytojas pirkimo proceduroje dalyvauja kartu
su kitais?

OTaip

®Ne

Jei taikytina, nuroda i pirkimo dali (-is), dél kurios (-iu) ekonominés
veiklos vykdytojas nori dalyvauti konkurse:



B. Informacija apie ekonominés veiklos vykdytojo teisinius atstovus #1

« Jei taikytina, nurodykite asmens (-y), jgalioto (-y) atstovauti ekonominés
veiklos vykdytojui Sios pirkimo proceddros tikslais, varda ir pavarde ir adresa:

C. Informacija apie réemimasi kity subjekty pajégumais

Ar siekdamas patenkinti IV dalyje nurodytus atrankos kriterijus ir V
dalyje nurodytus kriterijus bei taisykles (jei tokiy yra) ekonominés
veiklos vykdytojas remiasi kity subjekty pajégumais?

OTaip

®Ne



D. Informacija apie subrangovus, kuriy pajégumais ekonominés veiklos

vykdytojas nesiremia

« (Skirsnj reikia pildyti, tik jei Sios informacijos aiskiai reikalauja perkancioji
organizacija ar perkantysis subjektas.)

Ar ekonominés veiklos vykdytojas ketina kurias nors sutarties dalis
subrangos sutartimi pavesti atlikti treCiosioms salims?

OTaip

®Ne

+ Jei perkancioji organizacija ar perkantysis subjektas aiSkiai praso Sios
informacijos, Salia informacijos pagal Sj skirsnj, pateikite pagal Sios dalies
A ir B skirsnius ir lll dalj reikalaujamg informacijg apie kiekvieng susijusj
subrangova (subrangovy kategorijas).

11l dalis. Pasalinimo pagrindai

A. Su baudziamaisiais nuosprendziais susije pagrindai

Direktyvos 2014/24/ES 57 straipsnio 1 dalyje nustatyti Sie pasalinimo
pagrindai

Dalyvavimas nusikalstamos organizacijos veikloje

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu, buvo
nuteistas galutiniu teismo sprendimu uz dalyvavima nusikalstamos organizacijos
veikloje, o nuosprendis priimtas pries ne daugiau kaip penkerius metus arba kai
nuosprendyje aiskiai nustatytas pasalinimo laikotarpis tebesitesia? Kaip apibrézta
2008 m. spalio 24 d. Tarybos pamatinio sprendimo 2008/841/TVR dél kovos su
organizuotu nusikalstamumu 2 straipsnyje (OL L 300, 2008 11 11, p. 42).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne



Korupcija

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu, buvo
nuteistas galutiniu teismo sprendimu uz korupcija, o nuosprendis priimtas pries ne
daugiau kaip penkerius metus arba kai nuosprendyje aiskiai nustatytas pasalinimo
laikotarpis tebesitesia? Kaip apibrézta Konvencijos dél kovos su korupcija, susijusia
su Europos Bendrijy pareigunais ar Europos Sajungos valstybiy nariy pareigunais,
3 straipsnyje (OL C 195, 1997 6 25, p. 1) ir 2003 m. liepos 22 d. Tarybos pamatinio
sprendimo 2003/568/TVR dél kovos su korupcija privaciame sektoriuje 2 straipsnio
1 dalyje (OL L 192, 2003 7 31, p. 54). | pasalinimo pagrindus taip pat jtraukta
korupcija, kaip apibrézta perkanciosios organizacijos (perkanciojo subjekto) arba
ekonominés veiklos vykdytojo nacionalinéje teiséje.

Jusy atsakymas

OTaip

®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Sukciavimas

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar prieziiros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz sukciavimg, o nuosprendis priimtas
priesS ne daugiau kaip penkerius metus arba kai nuosprendyje aiskiai nustatytas
pasalinimo laikotarpis tebesitesia? Pagal Europos Bendrijy finansiniy interesy
apsaugos konvencijos 1 straipsnj (OL C 316, 1995 11 27, p. 48).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne



Teroristiniai nusikaltimai arba su teroristine veikla susije nusikaltimai

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz teroristinius nusikaltimus arba

su teroristine veikla susijusius nusikaltimus, o nuosprendis priimtas priesS ne
daugiau kaip penkerius metus arba kai nuosprendyje aiskiai nustatytas pasalinimo
laikotarpis tebesitesia? Kaip apibrézta 2002 m. birzelio 13 d. Tarybos pamatinio
sprendimo dél kovos su terorizmu 1 ir 3 straipsniuose (OL L 164, 2002 6 22, p. 3).
| pasalinimo pagrindus taip pat jtrauktas nusikalstamos veikos kurstymas, pagalba
ar bendrininkavimas jg vykdant arba késinimasis jg jvykdyti, kaip nurodyta to
pamatinio sprendimo 4 straipsnyje.

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Pinigu plovimas arba teroristy finansavimas

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar prieziiros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz pinigy plovimg arba teroristy
finansavima, o nuosprendis priimtas pries ne daugiau kaip penkerius metus

arba kai nuosprendyje aiskiai nustatytas pasalinimo laikotarpis tebesitesia? Kaip
apibrézta 2005 m. spalio 26 d. Europos Parlamento ir Tarybos direktyvos 2005/60/
EB dél finansy sistemos apsaugos nuo jos panaudojimo pinigy plovimui ir teroristy
finansavimui 1 straipsnyje (OL L 309, 2005 11 25, p. 15).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?
OTaip



®Ne

Vaikuy darbas ir kitos prekybos Zmonémis formos

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz vaiky darbg arba kitas prekybos
zmonémis formas, o nuosprendis priimtas prieS ne daugiau kaip penkerius metus
arba kai nuosprendyje aiskiai nustatytas pasalinimo laikotarpis tebesitesia?

Kaip apibrézta 2011 m. balandzio 5 d. Europos Parlamento ir Tarybos direktyvos
2011/36/ES deél prekybos zmonémis prevencijos, kovos su ja ir auky apsaugos,
pakeiCiancios Tarybos pamatinj sprendimg 2002/629/TVR, 2 straipsnyje (OL L 101,
2011 4 15, p. 1).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

B. Su mokesciu ar socialinio draudimo imoku mokéjimu susije pagrindai
Direktyvos 2014/24/ES 57 straipsnio 2 dalyje nustatytos Sios pasalinimo

priezastys

Mokesciu mokéjimas

Ar ekonomineés veiklos vykdytojas pazeidé savo pareigas, susijusias su mokesciy
mokeéjimu, tiek Salyje, kurioje yra jsisteiges, tiek perkanciosios organizacijos ar
perkanciojo subjekto valstybéje naréje, jei tai néra jo jsisteigimo salis?

Jusy atsakymas

OTaip

®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?
OTaip
®Ne
Socialinio draudimo imokuy mokéjimas
-8-



Ar ekonominés veiklos vykdytojas pazeidé savo pareigas, susijusias su socialinio
draudimo jmoky mokéjimu, tiek Salyje, kurioje yra jsisteiges, tiek perkanciosios
organizacijos ar perkanciojo subjekto valstybéje naréje, jei tai néra jo jsisteigimo
Salis?

Jusy atsakymas

OTaip

®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

@ Taip

ONe

URL

http://draudejai.sodra.lt/draudeju_viesi_duomenys/

Kodas

191630223

Emitentas

Valstybinio socialinio draudimo fondo valdyba prie Socialinés apsaugos ir darbo
ministerijos

C. Su nemokumu, interesu konfliktu ar profesiniais nusizengimais susije

pagrindai

Direktyvos 2014/24/ES 57 straipsnio 4 dalyje nustatyti Sie pasalinimo
pagrindai

Nemokumas

Ar ekonomines veiklos vykdytojui taikoma nemokumo ar likvidavimo procedura?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Susitarimas su kreditoriais

Ar ekonominés veiklos vykdytojas yra sudares susitarima su kreditoriais?

Jusy atsakymas



OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Sustabdyta verslo veikla

Ar ekonomineés veiklos vykdytojo verslo veikla yra sustabdyta?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Su kitais ekonominés veiklos vykdytojais sudaryti susitarimai, kuriais
siekta iskraipyti konkurencija

Ar ekonomines veiklos vykdytojas su kitais ekonominés veiklos vykdytojais yra
sudares susitarimuy, kuriais siekta iSkraipyti konkurencijg?

Jusy atsakymas

OTaip

®Ne

Pripazinimas kaltu dél sunkaus profesinio nusizengimo

Ar ekonominés veiklos vykdytojas yra pripazintas kaltu dél sunkaus profesinio
nusizengimo? Jei taikytina, zr. nacionalinéje teiséje, atitinkamame skelbime ar
pirkimo dokumentuose pateiktas apibreéztis.

Jusy atsakymas

OTaip

®Ne

Interesy konfliktas dél dalyvavimo pirkimo proceduroje

Ar ekonominés veiklos vykdytojas Zino apie kokius nors interesy konfliktus, kaip
nurodyta nacionalinéje teisése, atitinkamame skelbime ar pirkimo dokumentuose,
kylancius dél jo dalyvavimo pirkimo proceduroje?

Jusy atsakymas
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OTaip

®Ne

Tiesioginis arba netiesioginis dalyvavimas rengiant Sig pirkimo
procedura

Ar ekonominés veiklos vykdytojas arba su juo susijusi jimoné konsultavo
perkancigjg organizacijg ar perkantjjj subjekta arba kitaip dalyvavo rengiant
pirkimo procedurg?

Jusy atsakymas

OTaip

®Ne

Sutarties nutraukimas anksciau laiko, zala ar kitos panasios sankcijos
Ar ekonominés veiklos vykdytojas turejo tokios patirties: ankstesné viesoji
sutartis, ankstesné sutartis su perkanciuoju subjektu arba ankstesné koncesijos
sutartis buvo nutraukta anksciau laiko; arba buvo pareikalauta atlyginti su
ankstesne sutartimi susijusig Zalg ar skirtos kitos panasios sankcijos?

Jusy atsakymas

OTaip

®Ne

Pripazinimas kaltu dél fakty iskraipymo, informacijos nuslépimo,
negaléjimas pateikti reikalaujamy dokumentu ir su Sia procedura
susijusios konfidencialios informacijos gavimas

Ar ekonominés veiklos vykdytojas yra susijes su vienu is Siy atvejuy, kai jis :

a) buvo labai iSkreipes faktus pateikdamas informacija, reikalinga patikrinti, ar
néra pagrindy pasalinti, arba patikrinti atitiktj atrankos kriterijams;

b) slepé tokiag informacija;

c) delsé pateikti patvirtinamuosius dokumentus, kuriy reikalavo perkancioji
organizacija ar perkantysis subjektas, ir

d) siekeé daryti neteisetg jtakg perkanciosios organizacijos ar perkanciojo subjekto
sprendimy prieémimo procesui, kad gauty konfidencialios informacijos, dél kurios
per pirkimo procedlra jgyty nepagrista pranasuma, arba tycia teikti klaidinancios
informacijos, kuri gali turéti esminés jtakos sprendimams dél pasalinimo, atrankos
ar sutarties skyrimo?

Jusy atsakymas
OTaip
®Ne

D. ISimtinai nacionaliniai pasalinimo pagrindai




Ar taikomi iSimtinai nacionaliniai pasalinimo pagrindai, nurodyti
atitinkamame skelbime ar pirkimo dokumentuose?

ISimtinai nacionaliniai pasalinimo pagrindai

Kiti pasalinimo pagrindai, kurie gali bati numatyti perkanciosios organizacijos
ar perkanciojo subjekto valstybés narés nacionalinés teisés aktuose. Ar taikomi
iSimtinai nacionaliniai pasalinimo pagrindai, nurodyti atitinkamame skelbime ar
pirkimo dokumentuose?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

IV dalis. Atrankos kriterijai

a. Visy atrankos kriteriju bendra nuoroda

Dél atrankos kriteriju ekonominés veiklos vykdytojas pareiskia, kad
Jis atitinka visus reikalaujamus atrankos kriterijus

Jusy atsakymas

@Taip

ONe

Baigti

IV dalis. Baigiamieji pareiskimai

Ekonominés veiklos vykdytojai oficialiai pareiSkia, kad II-V dalyse pateikta
informacija yra tiksli ir teisinga ir kad ji pateikta visiskai suvokiant didelio fakty
iSkreipimo padarinius.
Ekonominés veiklos vykdytojai oficialiai pareiskia, kad pareikalavus gali
nedelsdami pateikti nurodytus sertifikatus ir kity formy jrodomuosius
dokumentus, iSskyrus tuo atvejus, kai:
a) perkancioji organizacija ar perkantysis subjektas turi galimybe atitinkamus
patvirtinamuosius dokumentus tiesiogiai gauti naudodamiesi prieiga prie bet

kurios i$ valstybiy nariy nemokamos nacionalinés duomeny bazés (su salyga,
-12-



kad ekonominés veiklos vykdytojas pateiké reikalingg informacija (interneto
adresg, iSduodanciajg institucijg ar jstaigq, tikslias dokumenty nuorodas),
kuri perkanciajai organizacijai ar perkanciajam subjektui leidzia tai padaryti.
Pareikalavus dél tokios prieigos turi buti pridetas atitinkamas sutikimas) arba
b) (priklausomai nuo Direktyvos 2014/24/ES 59 straipsnio 5 dalies antros
pastraipos jgyvendinimo nacionalingje teiséje) ne véliau kaip 2018 m. spalio
18 d. perkancioji organizacija ar perkantysis subjektas yra gavusi susijusius
dokumentus.
Ekonominés veiklos vykdytojai oficialiai sutinka [nurodyti perkanciaja
organizacijg ar perkantjjj subjekta, kaip nustatyta | dalies A skirsnyje] leisti
susipazinti su dokumentais, kuriais patvirtinama informacija, pateikta Sio
Europos bendrojo viesyjy pirkimy dokumento [nurodyti atitinkama dalj /
skirsnj / punktg (-us)], dél [nurodyti viesojo pirkimo procedira: (trumpas
aprasymas, paskelbimo Europos Sajungos oficialiajame leidinyje nuoroda,
nuorodos numeris)].

Data, vieta ir, jei reikia ar batina, parasas (-ai):

Data

02-07-2018

Vieta

Jurbarkas

Parasas
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Europos bendrasis viesuj irkim
dokul?'nentas (EBVPD) wu p “

I dalis. Informacija apie pirkimo procedura ir perkanciaja
organizacija ar perkantiji subjekta

Informacpia apie paskelbima

Vykdant pirkimo procedaras, kuriy kvietimas dalyvauti konkurse paskelbtas
Europos Sajungos oficialiajame leidinyje, informacija, kurios reikalaujama pagal

| dalj, bus atsiysta automatiskai, jeigu EBVPD sukurti ir uzpildyti naudojama
elektroniné EBVPD paslauga. Atitinkamo skelbimo Europos Sgjungos oficialiajame
leidinyje nuoroda:

Skelbimo numeris OL S:

OL S URL

National Official Journal

Jei kvietimas dalyvauti konkurse neskelbiamas Europos Sajungos oficialiajame
leidinyje arba jei jo skelbti nereikalaujama, perkancioji organizacija arba
perkantysis subjektas turi jrasyti informacija, kuri leisty nedviprasmiskai atpazinti
pirkimo procedurg (pvz., paskelbimo nacionaliniu lygmeniu nuorodg).

Perkanciojo subjekto tapatybé

Oficialus pavadinimas:

UAB "Verslo aptarnavimo centras"”
Salis:

Lietuva

Informacija apie pirkimo procedura

Type of procedure

Open procedure

Vardas ir pavardeé / Pavadinimas:

(2018-ESO- 519) NV vidutinio slégio skirstomojo dujotiekio iki sklypy Birutés g.,
Maironio g. ir kt. gatvése, Radviliskis, RadviliSkio m. sav., projektavimo paslaugos
ir statybos darby pirkimas

Trumpas aprasymas:



(2018-ESO- 519) NV vidutinio slégio skirstomojo dujotiekio iki sklypy Birutés g.,
Maironio g. ir kt. gatvése, Radviliskis, RadviliSkio m. sav., projektavimo paslaugos
ir statybos darbai

Perkanciosios organizacijos ar perkanciojo subjekto (jei taikoma)
priskirtas dokumento numeris:

2018-ESO-519

Il dalis. Informacija apie ekonominés veiklos vykdytoja

A. Informacija apie ekonominés veiklos vykdytoja

Vardas ir pavardeé / Pavadinimas:
“Projektai ir Co", UAB

Gatveé ir namo numeris:
Uztvankos g. 17

Pasto kodas:

74202

Miestas:

Dainiai, Jurbarko raj.

Salis:

Lietuva

Interneto adresas (jei taikoma):
www.projektai.co

E. pastas:
projektavimas@zilinskis.com
Telefonas:

+370 447 70120

Asmuo ar asmenys rySiams:
Tomas Gudaitis

PVM mokeétojo kodas, jei yra:
LT100010333417

Jei PVM mokeétojo kodo néra, nurodykite kita nacionalinj identifikacini
numerij (jei reikia ir jei toks yra)
Ar ekonominés veiklos vykdytojas yra labai maza, mazoji ar vidutiné
imoné?

@ Taip

ONe



Tik tuo atveju, kai pirkimas rezervuotas: ar ekonominés veiklos
vykdytojas yra globojama darbo grupé (neigaliuju socialiné imonée),
socialiné imoné? Ar jis vykdys sutarti pagal globojamuy darbo grupiuy
(neigaliuju socialiniy imoniu) uzimtumo programas?

OTaip

®Ne

Jei taikoma, ar ekonominés veiklos vykdytojas itrauktas i oficialy
patvirtinty ekonominés veiklos vykdytoju sarasa arba ar jis turi
lygiaverti sertifikata (pvz., pagal nacionaline (iSankstine) kvalifikacijos
vertinimo sistema)?

OTaip

®Ne

« Be to, uzpildykite trukstama informacija IV dalies A, B, C arba D skirsniuose,
atsizvelgdami | konkrety atvejj TIK jei to reikalaujama atitinkamame skelbime
arba pirkimo dokumentuose:

e) Ar ekonominés veiklos vykdytojas galés pateikti sertifikata dél
socialinio draudimo imokuy ir mokesciuy mokéjimo arba pateikti
informacija, kuri leisty perkanciajai organizacijai ar perkanciajam
subjektui ji gauti tiesiogiai naudojantis prieiga prie bet kurios is
valstybiuy nariu nemokamos nacionalinés duomenu bazés?

@ Taip

ONe

Jei atitinkami dokumentai prieinami elektroniniu budu, nurodykite:
http://draudejai.sodra.lt/draudeju_viesi_duomenys/

Ar ekonominés veiklos vykdytojas pirkimo proceduroje dalyvauja kartu
su kitais?

OTaip

®Ne

Jei taikytina, nuroda i pirkimo dali (-is), dél kurios (-iu) ekonominés
veiklos vykdytojas nori dalyvauti konkurse:



B. Informacija apie ekonominés veiklos vykdytojo teisinius atstovus #1

« Jei taikytina, nurodykite asmens (-y), jgalioto (-y) atstovauti ekonominés
veiklos vykdytojui Sios pirkimo proceddros tikslais, varda ir pavarde ir adresa:

Vardas
Tomas
Pavardeé
Gudaitis
Gimimo data

Gimimo vieta

Gatveé ir namo numeris:

Pasto kodas:
Miestas:

Dainiai, Jurbarko raj.
Salis:

Lietuva

E. pastas:

Telefonas:

Pareigos arba statusas:
Direktorius

Prireikus pateikite iSsamia informacija apie atstovavima (forma, aprépti,

paskirtij ir t. t.):

C. Informacija apie réemimasi kity subjekty pajégumais

Ar siekdamas patenkinti IV dalyje nurodytus atrankos kriterijus ir V
dalyje nurodytus kriterijus bei taisykles (jei tokiy yra) ekonominés
veiklos vykdytojas remiasi kity subjekty pajégumais?

OTaip
®Ne



D. Informacija apie subrangovus, kuriy pajégumais ekonominés veiklos

vykdytojas nesiremia

« (Skirsnj reikia pildyti, tik jei Sios informacijos aiskiai reikalauja perkancioji
organizacija ar perkantysis subjektas.)

Ar ekonominés veiklos vykdytojas ketina kurias nors sutarties dalis
subrangos sutartimi pavesti atlikti treCiosioms salims?

OTaip

®Ne

+ Jei perkancioji organizacija ar perkantysis subjektas aiSkiai praso Sios
informacijos, Salia informacijos pagal Sj skirsnj, pateikite pagal Sios dalies
A ir B skirsnius ir lll dalj reikalaujamg informacijg apie kiekvieng susijusj
subrangova (subrangovy kategorijas).

11l dalis. Pasalinimo pagrindai

A. Su baudziamaisiais nuosprendziais susije pagrindai

Direktyvos 2014/24/ES 57 straipsnio 1 dalyje nustatyti Sie pasalinimo
pagrindai

Dalyvavimas nusikalstamos organizacijos veikloje

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu, buvo
nuteistas galutiniu teismo sprendimu uz dalyvavima nusikalstamos organizacijos
veikloje, o nuosprendis priimtas pries ne daugiau kaip penkerius metus arba kai
nuosprendyje aiskiai nustatytas pasalinimo laikotarpis tebesitesia? Kaip apibrézta
2008 m. spalio 24 d. Tarybos pamatinio sprendimo 2008/841/TVR dél kovos su
organizuotu nusikalstamumu 2 straipsnyje (OL L 300, 2008 11 11, p. 42).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne



Korupcija

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu, buvo
nuteistas galutiniu teismo sprendimu uz korupcija, o nuosprendis priimtas pries ne
daugiau kaip penkerius metus arba kai nuosprendyje aiskiai nustatytas pasalinimo
laikotarpis tebesitesia? Kaip apibrézta Konvencijos dél kovos su korupcija, susijusia
su Europos Bendrijy pareigunais ar Europos Sajungos valstybiy nariy pareigunais,
3 straipsnyje (OL C 195, 1997 6 25, p. 1) ir 2003 m. liepos 22 d. Tarybos pamatinio
sprendimo 2003/568/TVR dél kovos su korupcija privaciame sektoriuje 2 straipsnio
1 dalyje (OL L 192, 2003 7 31, p. 54). | pasalinimo pagrindus taip pat jtraukta
korupcija, kaip apibrézta perkanciosios organizacijos (perkanciojo subjekto) arba
ekonominés veiklos vykdytojo nacionalinéje teiséje.

Jusy atsakymas

OTaip

®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Sukciavimas

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar prieziiros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz sukciavimg, o nuosprendis priimtas
priesS ne daugiau kaip penkerius metus arba kai nuosprendyje aiskiai nustatytas
pasalinimo laikotarpis tebesitesia? Pagal Europos Bendrijy finansiniy interesy
apsaugos konvencijos 1 straipsnj (OL C 316, 1995 11 27, p. 48).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne



Teroristiniai nusikaltimai arba su teroristine veikla susije nusikaltimai

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz teroristinius nusikaltimus arba

su teroristine veikla susijusius nusikaltimus, o nuosprendis priimtas priesS ne
daugiau kaip penkerius metus arba kai nuosprendyje aiskiai nustatytas pasalinimo
laikotarpis tebesitesia? Kaip apibrézta 2002 m. birzelio 13 d. Tarybos pamatinio
sprendimo dél kovos su terorizmu 1 ir 3 straipsniuose (OL L 164, 2002 6 22, p. 3).
| pasalinimo pagrindus taip pat jtrauktas nusikalstamos veikos kurstymas, pagalba
ar bendrininkavimas jg vykdant arba késinimasis jg jvykdyti, kaip nurodyta to
pamatinio sprendimo 4 straipsnyje.

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Pinigu plovimas arba teroristy finansavimas

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar prieziiros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz pinigy plovimg arba teroristy
finansavima, o nuosprendis priimtas pries ne daugiau kaip penkerius metus

arba kai nuosprendyje aiskiai nustatytas pasalinimo laikotarpis tebesitesia? Kaip
apibrézta 2005 m. spalio 26 d. Europos Parlamento ir Tarybos direktyvos 2005/60/
EB dél finansy sistemos apsaugos nuo jos panaudojimo pinigy plovimui ir teroristy
finansavimui 1 straipsnyje (OL L 309, 2005 11 25, p. 15).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?
OTaip



®Ne

Vaikuy darbas ir kitos prekybos Zmonémis formos

Ar pats ekonominés veiklos vykdytojas ar bet kuris asmuo, kuris yra jo
administracijos, valdymo ar priezitros organo narys arba turi atstovavimo,
sprendimo ar kontrolés jgaliojimus to ekonominés veiklos vykdytojo atzvilgiu,
buvo nuteistas galutiniu teismo sprendimu uz vaiky darbg arba kitas prekybos
zmonémis formas, o nuosprendis priimtas prieS ne daugiau kaip penkerius metus
arba kai nuosprendyje aiskiai nustatytas pasalinimo laikotarpis tebesitesia?

Kaip apibrézta 2011 m. balandzio 5 d. Europos Parlamento ir Tarybos direktyvos
2011/36/ES deél prekybos zmonémis prevencijos, kovos su ja ir auky apsaugos,
pakeiCiancios Tarybos pamatinj sprendimg 2002/629/TVR, 2 straipsnyje (OL L 101,
2011 4 15, p. 1).

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

B. Su mokesciu ar socialinio draudimo imoku mokéjimu susije pagrindai
Direktyvos 2014/24/ES 57 straipsnio 2 dalyje nustatytos Sios pasalinimo

priezastys

Mokesciu mokéjimas

Ar ekonomineés veiklos vykdytojas pazeidé savo pareigas, susijusias su mokesciy
mokeéjimu, tiek Salyje, kurioje yra jsisteiges, tiek perkanciosios organizacijos ar
perkanciojo subjekto valstybéje naréje, jei tai néra jo jsisteigimo salis?

Jusy atsakymas

OTaip

®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?
OTaip
®Ne
Socialinio draudimo imokuy mokéjimas
-8-



Ar ekonominés veiklos vykdytojas pazeidé savo pareigas, susijusias su socialinio
draudimo jmoky mokéjimu, tiek Salyje, kurioje yra jsisteiges, tiek perkanciosios
organizacijos ar perkanciojo subjekto valstybéje naréje, jei tai néra jo jsisteigimo
Salis?

Jusy atsakymas

OTaip

®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

@ Taip

ONe

URL

http://draudejai.sodra.lt/draudeju_viesi_duomenys/

Kodas

191630223

Emitentas

Valstybinio socialinio draudimo fondo valdyba prie Socialinés apsaugos ir darbo
ministerijos

C. Su nemokumu, interesu konfliktu ar profesiniais nusizengimais susije

pagrindai

Direktyvos 2014/24/ES 57 straipsnio 4 dalyje nustatyti Sie pasalinimo
pagrindai

Nemokumas

Ar ekonomines veiklos vykdytojui taikoma nemokumo ar likvidavimo procedura?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Susitarimas su kreditoriais

Ar ekonominés veiklos vykdytojas yra sudares susitarima su kreditoriais?

Jusy atsakymas



OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Sustabdyta verslo veikla

Ar ekonomineés veiklos vykdytojo verslo veikla yra sustabdyta?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

Su kitais ekonominés veiklos vykdytojais sudaryti susitarimai, kuriais
siekta iskraipyti konkurencija

Ar ekonomines veiklos vykdytojas su kitais ekonominés veiklos vykdytojais yra
sudares susitarimuy, kuriais siekta iSkraipyti konkurencijg?

Jusy atsakymas

OTaip

®Ne

Pripazinimas kaltu dél sunkaus profesinio nusizengimo

Ar ekonominés veiklos vykdytojas yra pripazintas kaltu dél sunkaus profesinio
nusizengimo? Jei taikytina, zr. nacionalinéje teiséje, atitinkamame skelbime ar
pirkimo dokumentuose pateiktas apibreéztis.

Jusy atsakymas

OTaip

®Ne

Interesy konfliktas dél dalyvavimo pirkimo proceduroje

Ar ekonominés veiklos vykdytojas Zino apie kokius nors interesy konfliktus, kaip
nurodyta nacionalinéje teisése, atitinkamame skelbime ar pirkimo dokumentuose,
kylancius dél jo dalyvavimo pirkimo proceduroje?

Jusy atsakymas

-10-



OTaip

®Ne

Tiesioginis arba netiesioginis dalyvavimas rengiant Sig pirkimo
procedura

Ar ekonominés veiklos vykdytojas arba su juo susijusi jimoné konsultavo
perkancigjg organizacijg ar perkantjjj subjekta arba kitaip dalyvavo rengiant
pirkimo procedurg?

Jusy atsakymas

OTaip

®Ne

Sutarties nutraukimas anksciau laiko, zala ar kitos panasios sankcijos
Ar ekonominés veiklos vykdytojas turejo tokios patirties: ankstesné viesoji
sutartis, ankstesné sutartis su perkanciuoju subjektu arba ankstesné koncesijos
sutartis buvo nutraukta anksciau laiko; arba buvo pareikalauta atlyginti su
ankstesne sutartimi susijusig Zalg ar skirtos kitos panasios sankcijos?

Jusy atsakymas

OTaip

®Ne

Pripazinimas kaltu dél fakty iskraipymo, informacijos nuslépimo,
negaléjimas pateikti reikalaujamy dokumentu ir su Sia procedura
susijusios konfidencialios informacijos gavimas

Ar ekonominés veiklos vykdytojas yra susijes su vienu is Siy atvejuy, kai jis :

a) buvo labai iSkreipes faktus pateikdamas informacija, reikalinga patikrinti, ar
néra pagrindy pasalinti, arba patikrinti atitiktj atrankos kriterijams;

b) slepé tokiag informacija;

c) delsé pateikti patvirtinamuosius dokumentus, kuriy reikalavo perkancioji
organizacija ar perkantysis subjektas, ir

d) siekeé daryti neteisetg jtakg perkanciosios organizacijos ar perkanciojo subjekto
sprendimy prieémimo procesui, kad gauty konfidencialios informacijos, dél kurios
per pirkimo procedlra jgyty nepagrista pranasuma, arba tycia teikti klaidinancios
informacijos, kuri gali turéti esminés jtakos sprendimams dél pasalinimo, atrankos
ar sutarties skyrimo?

Jusy atsakymas
OTaip
®Ne

D. ISimtinai nacionaliniai pasalinimo pagrindai




Ar taikomi iSimtinai nacionaliniai pasalinimo pagrindai, nurodyti
atitinkamame skelbime ar pirkimo dokumentuose?

ISimtinai nacionaliniai pasalinimo pagrindai

Kiti pasalinimo pagrindai, kurie gali bati numatyti perkanciosios organizacijos
ar perkanciojo subjekto valstybés narés nacionalinés teisés aktuose. Ar taikomi
iSimtinai nacionaliniai pasalinimo pagrindai, nurodyti atitinkamame skelbime ar
pirkimo dokumentuose?

Jusy atsakymas
OTaip
®Ne

Ar Si informacija ES valstybés narés duomeny bazéje nemokamai prieinama
valdzios institucijoms?

OTaip

®Ne

IV dalis. Atrankos kriterijai

a. Visy atrankos kriteriju bendra nuoroda

Dél atrankos kriteriju ekonominés veiklos vykdytojas pareiskia, kad
Jis atitinka visus reikalaujamus atrankos kriterijus

Jusy atsakymas

@Taip

ONe

Baigti

IV dalis. Baigiamieji pareiskimai

Ekonominés veiklos vykdytojai oficialiai pareiSkia, kad II-V dalyse pateikta
informacija yra tiksli ir teisinga ir kad ji pateikta visiskai suvokiant didelio fakty
iSkreipimo padarinius.
Ekonominés veiklos vykdytojai oficialiai pareiskia, kad pareikalavus gali
nedelsdami pateikti nurodytus sertifikatus ir kity formy jrodomuosius
dokumentus, iSskyrus tuo atvejus, kai:
a) perkancioji organizacija ar perkantysis subjektas turi galimybe atitinkamus
patvirtinamuosius dokumentus tiesiogiai gauti naudodamiesi prieiga prie bet

kurios i$ valstybiy nariy nemokamos nacionalinés duomeny bazés (su salyga,
-12-



kad ekonominés veiklos vykdytojas pateiké reikalingg informacija (interneto
adresg, iSduodanciajg institucijg ar jstaigq, tikslias dokumenty nuorodas),
kuri perkanciajai organizacijai ar perkanciajam subjektui leidzia tai padaryti.
Pareikalavus dél tokios prieigos turi buti pridetas atitinkamas sutikimas) arba
b) (priklausomai nuo Direktyvos 2014/24/ES 59 straipsnio 5 dalies antros
pastraipos jgyvendinimo nacionalingje teiséje) ne véliau kaip 2018 m. spalio
18 d. perkancioji organizacija ar perkantysis subjektas yra gavusi susijusius
dokumentus.
Ekonominés veiklos vykdytojai oficialiai sutinka [nurodyti perkanciaja
organizacijg ar perkantjjj subjekta, kaip nustatyta | dalies A skirsnyje] leisti
susipazinti su dokumentais, kuriais patvirtinama informacija, pateikta Sio
Europos bendrojo viesyjy pirkimy dokumento [nurodyti atitinkama dalj /
skirsnj / punktg (-us)], dél [nurodyti viesojo pirkimo procedira: (trumpas
aprasymas, paskelbimo Europos Sajungos oficialiajame leidinyje nuoroda,
nuorodos numeris)].

Data, vieta ir, jei reikia ar batina, parasas (-ai):

Data

03-05-2018

Vieta

Jurbarkas i

Parasas ,/;/

£
FROJER Tarca TD"A'SGUM 3 y
DIREKTCANE
g
! lr’
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ZILINSKIS CO
/
IGALIOJIMAS

2018-07-04 Nr. 28
Jurbarkas

Jgalioju atstovauti ,,Zilinskis ir Co®,

UAB (toliau — Bendrove), Bendrovei dalyvaujant vieSyjy pirkimy ir vandentvarkos, energetikos,

transporto ar paSto paslaugy srities perkanéiyjy subjekty atliekamy pirkimy bei projekto konkursy

(toliau — Pirkimy) procediirose ir ,,Zilinskis ir Co“, UAB vardu:

pasiradyti (jskaitant, bet neapsiribojant ir elektroninémis priemonémis, ir elektroniniu
paraSu) bei pateikti perkandiosioms organizacijoms ir perkantiesiems subjektams
Bendrovés paraidkas, pasililymus, pretenzijas ir visus kitus su Pirkimais susijusius
dokumentus, paklausimus bei atsakymus i paklausimus dél Pirkimo dokumentuose
i§destyty dalyky ir pan.;

pasiraSyti su dalyvavimu Pirkimuose susijusius ketinimy protokolus, susitarimus ir

preliminarigsias sutartis su numatomais pasitelkti subrangovais/ subtiekéjais;

tvirtinti dokumenty, susijusiy su dalyvavimu Pirkimuose, kopijy tikruma;

dalyvauti perkan¢iyjy 6rganizacijq ir perkanéiyjy sﬁbjektu organizuojamuose
susitikimuose su tickéjais bei derybose, pasirasyti atitinkamus dokumentus;
dalyvauti susipaZinimo su Pirkimuose tiekéjy / dalyviy pateiktomis paraiskomis /

pasiiilymais procedirose.

Sis jgaliojimas galioja vienerius metus skaidiuojant nuo jo sudarymo dienos.

Direktorius

dr. Zilvinas Zilinskis

+ZILINSKIS IR CO*, UAB
DUOMENYS APIE JURIDIN] ASMEN] KAUPIAMI IR SAUGOMI LR JURIDINIY ASMENU REGISTRE

UZTVANKOS G. 17, DAINIU K. LT-74202, JURBARKO R., LIETUVA WWW_.ZILINSKIS.COM
TEL.+370 447 70120/ +370 698 51552, FAKS. +370 447 70128/ INFO@ZILINSKIS . COM



ZVLI%SIS co

IGALIOJIMAS

2018-01-04 Nr. 02
Jurbarkas

Igalioju atstovauti A.Zilinskio ir ko
UAB (toliau — Bendrove), Bendrovei dalyvaujant vie§uyjy pirkimy ir vandentvarkos, energetikos,
transporto ar pasSto paslaugy srities perkanciyjy subjekty atliekamy pirkimy bei projekto konkursy
(toliau — Pirkimy) procediirose ir A.Zilinskio ir ko UAB vardu:
- pasiraSyti (jskaitant, bet neapsiribojant ir elektroninémis priemonémis, ir elektroniniu
paraSu) bei pateikti perkandiosioms organizacijoms ir perkantiesiems subjektams
Bendrovés paraiSkas, pasitilymus, pretenzijas ir visus kitus su Pirkimais susijusius
dokumentus, paklausimus bei atsakymus j paklausimus dél Pirkimo dokumentuose
1Sdestyty dalyky ir pan.;
- pasirasyti su dalyvavimu Pirkimuose susijusius ketinimy protokolus, susitarimus ir
preliminarigsias sutartis su numatomais pasitelkti subrangovais/ subtiekéjais;
- tvirtinti dokumenty, susijusiy su dalyvavimu Pirkimuose, kopijy tikruma;
- dalyvauti perkan¢iyjy organizacijy ir perkandiyjy subjekty organizuojamuose
susitikimuose su tiekéjais bei derybose, pasira$yti atitinkamus dokumentus;
- dalyvauti susipazinimo su Pirkimuose tiekéjy / dalyviy pateiktomis paraidkomis /
pasiiilymais procediirose.

- Sis jgaliojimas galioja vienerius metus skai¢iuojant nuo jo sudarymo dienos.
s o

Direktorius dr. Zilvinas Zilinskis

A.ZILINSKIO IR KO UAB
DUOMENYS APIE JURIDIN] ASMEN| KAUPIAMI IR SAUGOMI LR JURIDINIY ASMENU REGISTRE

UZTVANKOS G. 17 DAINIY K. LT-74202 JURBARKO R. LIETUVA WWW.ZILINSKIS.COM
TEL.. +370 447 70120/ +370 698 51552 FAKS.: +370 447 70128 / +370 698 51553 INFO@ZILINSKIS.COM
KODAI 1581 02142 / LT581 021411



